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Microsoft Excel Lab: Data Analysis 
The purpose of this lab is to prepare the student to use Excel as a tool for analyzing data 
taken in other courses.  
 
The example used here comes from a Freshman physics lab with measurements on the 
position of a falling object versus time. The spreadsheet layout and original data are 
provided. You are to copy the data to another worksheet, to preserve the original data. 
You will then perform computations on the data and plot it. 
 
Download file “Data Analysis.xls” from the course web site. Store it in your directory 

H:\CSC100\Excel. Alternatively, prepare an Excel file named “Data Analysis.xls” 
identical to the printed copy attached to this lab. 

Start Excel. 
File | Open 

In the Open dialog box, click the down-arrow of the “Look in:” box 

 to select directory 
“H:\CSC100\Excel”. Select file “Data Analysis.xls”. 

This file contains the raw data from the experiment, plus labels for rows and 
columns. 

Label tab 
Double-click on the tab at the bottom of the worksheet. Its current label is 

“Sheet1”. The label will be highlighted. 

 Type “Original Data” as the new label. 

Press Enter.  
Insert a new worksheet: Insert | Worksheet. 
Label the new worksheet as: “Falling Body Lab” 
Copy data on “Original Data” to “Falling Body Lab”. 

Click on the “Original Data” tab. 
Click on the corner blank label cell. This is a gray cell that is above row 1 and to 

the left of column A.  The whole spreadsheet 
will be highlighted. 

Edit | Copy. The contents of the spreadsheet are copied to the clipboard. 
Click on the “Falling Body Lab” tab. 
Click on cell A1. 

Edit | Paste.  A copy of the data is copied from the clipboard to the 
spreadsheet. 
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Click anywhere on the spreadsheet to deselect the whole sheet. The highlighting 
will disappear. 

Column headings. 
Insert the label “Average d” in cell G2. 
Insert the label “Time (s)” in cell H2. 

Calculate the average of the distance data in each row, storing the result in the “Average 
d” column. 

Click in cell G3. 
Click the “Edit formula” equal sign in the row above the column labels, next to 

the formula edit box.  
Click the down arrow in the selection box to the left, and select “More 

functions…”.  
In the “Paste Function” dialog box, under “Function category”, select 

“Statistical”.  
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In the “Paste Function” dialog box, under “Function name”, select “Average”. 

 
Click “OK” in the “Paste Function” dialog box. The “Average” dialog box will 

appear. It will be obscuring parts of the spreadsheet you want to see. 
Move the “Average” dialog box. 

Place the mouse cursor in the blank gray area to the left of the “OK” 
button. 

Use the left mouse button to left-drag the “Average” dialog box so that the 
upper left corner is about in the upper left corner of cell B15. 

 
Click in cell B3 and drag through cell F3. In the “Average” dialog box, 

you should now see the code “B3:F3” appearing in the “Number 

1” edit box.  
Click the “OK” button in the “Average” dialog box. The dialog box will 

disappear. Cell G3 will now contain a number. The “Edit formula” 
edit box will now display the formula “=AVERAGE(B3:F3)”. 

Copy the formula to compute the average of other rows of data. 
Click on cell G3 to select it. 
Place the mouse cursor on the lower right corner of cell G3. The lower 

right corner has a solid black square. The mouse cursor will change 
to a thick black plus-sign. 

Use the left mouse button to drag the corner down to cell G12. 
Calculate the actual times. The time code in the left column is an index to time. Twenty 

(20) of these time codes equal one second. Each tick of the time code 
therefore is 0.05 seconds. 
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Click in cell H3. 

Type “=A3/20”. Press Enter.  
Reselect cell H3. The formula “=A3/20” will appear in the Formula Edit box. 

 
Use the left mouse button to drag this formula down to cell H12. 

Format the cells with data as numbers. Set the number of decimal places to an appropriate 
number. 

Format the raw data cells. 
Select cell B3. 
Push and hold the shift key. Select cell F12. The rectangle of cells from B3 

through F12 will become highlighted. 
Select Format | Cells. 

Select the Number sheet on the “Format Cells” dialog box. 
Select “Number” from the “Category:” list box. 
In the “Decimal Places” edit box, select or type “1”. 
Press “OK” in the “Format Cells” dialog box. 

Format the “Average d” distance data. 
Select cells G3 through G12. 
Select the Number sheet on the “Format Cells” dialog box. 
Select “Number” from the “Category:” list box. 
In the “Decimal Places” edit box, select or type “1”. 
Press “OK” in the “Format Cells” dialog box. 

Format the “Time (s)” time lapse data. 
Select cells H3 through H12. 
Select the Number sheet on the “Format Cells” dialog box. 
Select “Number” from the “Category:” list box. 
In the “Decimal Places” edit box, select or type “2”. 
Press “OK” in the “Format Cells” dialog box. 

 
Compute sample velocity data. 
Prepare headings for velocity data. 

Highlight cell A2. Edit | Copy. 
Select cell A15. 
Select Edit | Paste. 
Select cell A16. 
Click on the equal sign next to the formula edit box. 

Click on cell A3. “=A3” will appear in the formula edit box. 
Type in “+0.5” and click on the green checkmark.  Cell A16 will now 

display “1.5”. 
Click on cell A16. Use the left mouse button to drag the copy handle to cell A24. 

Cell A24 will contain 9.5. 
Enter labels for velocity data. 

Enter “v1” into cell B15. 
Select cell B15 again. 
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Use the left mouse button to drag the copy handle to cell F15. The cells will now 
contain v2 through v5. 

Click in cell B16. 
Click on the equal sign next to the formula edit box. 
Drag the “Formula result=” box down and to the right so that the column 

headings are visible. 
Type a left parenthesis “(“. 
Click on cell B4. 
Enter a minus sign. 
Click on cell B3. 
Enter “)/(”. This is a right parenthesis, a division sign, and a left parenthesis. 
Click on cell H4. 
Enter a minus sign. 
Click on cell H3. 
Enter a right parenthesis “)”. 
Click to the left of “H4” in the formula edit box. Type in a dollar sign “$” to make 

reference to column H an absolute reference. 
Click to the left of “H3” in the formula edit box. Type in a dollar sign “$” to make 

reference to column H an absolute reference. 
Click the “OK” button on the “Formula result=” box. 
Click on cell B16. 
Use the left mouse button to drag the formula to cell F24. Numbers should be 

visible now in the rectangle having corners (B16:F24). See the 
next line if this does not work. 

In Excel 97, drag B16 to F16. Then, highlight B16 through F16, and drag 
the row to F24. This is a two-step operation rather than just a one-
step operation. 

Enter label for velocity computation 
Select cell G15. Enter the label “Average v”. 

Compute the average velocity for each time. 
Click on cell G16. 
Click on the equal sign “=” next to the formula edit box. 
Click on the down arrow to select a function. Select “More functions…”. 
In the “Paste Function” dialog box, select “Statistical”. 
In the “Paste Function” dialog box, select “AVERAGE”. 
Click the “OK” button in the “Paste Function” dialog box. 
Drag the “Average” dialog box to a new position that does not obscure the data. 
Select cells B16 through F16. “B16:F16” will appear in the edit box next to 

“Number 1”. 
Click the “OK” button in the “Average” dialog box. 
Select cell G16. 
Use the left mouse button to drag the copy handle to cell G24.  

Record the times for which the velocity computations apply. 
Select cell H15. Enter the label “Time (s)”. 
Select cell H16. 
Click on the equal sign “=” next to the formula edit box. 
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Click on cell H3. 
Type “+(”. This is a plus sign, followed by a left parenthesis. 
Click on cell H4. 
Type a minus sign “-“. 
Click on cell H3. 
Type “)/2”. This is a right parenthesis, a division sign, and the number two. 
Click the “OK” button in the “Formula result =” edit box. 
Drag this formula to cell H24. 

Plot the average velocity data. 
Select cells G15:G24. 
On the Tools menu, select “Data Analysis…”. 
In the “Data Analysis” dialog box, select “Regression”. You might need to scroll 

down to find this option. 
Click the “OK” button in the “Data Analysis” dialog box. The “Regression” 

dialog box will appear. 
Drag the “Regression” dialog box to a location that does not obscure the 

“Average v” and “Time (s)” velocity data. 
In the “Input” section of the “Regression” dialog box, highlight the entry in the 

“Input Y-Range:” edit box. 
Again, select cells G15:G24. 
In the “Input” section of the “Regression” dialog box, highlight the entry in the 

“Input X-Range:” edit box. 
Select cells H15:H24. 
In the “Output Options” section of the “Regression” dialog box, highlight the 

contents of the edit box next to “New Worksheet Ply:”. Type in “Lin Regr 
on Average V”. 

In the “Residuals” section of the “Regression” dialog box, check all options. 
Click the “OK” button of the “Regression” dialog box. A new worksheet is 

created in the Excel workbook, labeled “Lin Regr on Average V”. 
Two plots appear on this new worksheet, one partially overlaying the other. 
Drag the plot labeled “Time (s) Line Fit Plot” so that the upper left corner is in the 

upper left corner of cell A40. Use the sizing handles to cause the lower 
right corner of the plot to be in the lower right corner of cell F55. 

Click on the plot title, “Time (s) Line Fit Plot”. Highlight the title. Type the new 
title “Regression on Average Velocity”. 

Click on the legend. Push the delete key. 
Click in the gray plot area. The gray plot move handles will display. Drag the 

right edge of the plot so that the right gray edge is at the boundary 
between columns E and F. 

Drag the plot labeled “Time (s) Residual Plot” so that the upper left corner is in 
the upper left corner of cell A57. Use the sizing handles to cause the lower 
right corner of the plot to be in the lower right corner of cell F66. 

Click on the plot title, “Time (s) Residual Plot”. Highlight the title. Type the new 
title “Average Velocity Regression Residual Plot”. 
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Click in the gray plot area. The gray plot move handles will display. Drag the 
edges of the plot so that they are immediately below the gray edges of the 
“Regression on Average Velocity”. 
 

Format all cells having numbers with fractions, that do not include “E” in the number, so 
that they have 3 places to the right of the decimal point. 

Select cells that need to be formatted. 
On the Format menu, select “Cells…”. 
In the “Category” selection list on the “Number” sheet of the “Format Cells” 

dialog box, select “Number”. 
In the “Decimal Places” edit box on the “Number” sheet of the “Format Cells” 

dialog box, make the number equal to 3. 
Click the “OK” button in the “Format Cells” dialog box. 

Format all cells having numbers that have an “E” in the number to Scientific notation 
with 3 decimal places. 

Select the cells that need to be formatted. 
On the Format menu, select “Cells…”. 
In the “Category” selection list on the “Number” sheet of the “Format Cells” 

dialog box, select “Scientific”. 
In the “Decimal Places” edit box on the “Number” sheet of the “Format Cells” 

dialog box, make the number equal to 3. 
Click the “OK” button in the “Format Cells” dialog box. 

Adjust the width of columns to fit the data. 
Select column A by clicking on the A at the top of the column. 
Hold the shift key and select column I. 
Place the cursor between columns I and J. Double click. The columns will adjust 

width. 
Adjust the output so that it will print on one Landscape page wide. 

Select File | Page Setup… 
Click on the “Page” tab. 
Select “Landscape” Orientation. 
In the “Scaling” section of “Page” sheet of the “Page Setup” dialog box, select 

“Fit to:” 1 page wide by 2 pages tall. 
Click the “OK” button of the “Page Setup” dialog box. 

 
Prepare and print the spreadsheets. Note that each spreadsheet in a workbook must be 

formatted separately. Formatting one spreadsheet has no affect on other 
spreadsheets in the same workbook. 

Setup the headers and footers on spreadsheet “Lin Regr on Average V”. 
File | Page Setup… 
Click on the “Header/Footer” tab. 
Click the “Custom Header” button. 
Click in the “Left Section” edit box. Type your name in the edit box. 
Click in the “Center Section”. Click on the File icon. The File icon looks 

like a white sheet of paper with the upper right corner bent, and a 
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green X centered on the left edge.  This inserts the code 
&[File]. This causes the file name to be printed. 

Click in the “Right Section”. Click on the Worksheet icon. The Worksheet 

icon looks like  This inserts the code &[Tab]. This causes the 
title on the worksheet tab to be printed. 

Click the “OK” button on the “Header” dialog box. 
Click the “Custom Footer” button on the “Page Setup” dialog box. 
Click in the “Left Section”. Click on the Date icon. The Date icon looks 

like two pages from a calendar.  This inserts the code &[Date]. 
This causes the date to be printed.  

Press the spacebar. Click on the Time icon. The time icon looks like a 

clock.  This inserts the code &[Time]. This causes the time to 
be printed. 

Click in the “Right Section”. Click on the “Page” icon. The Page icon 
looks like a white sheet with the upper left corner bent, with a 

pound sign # in the center.  This inserts the code &[Page]. This 
causes the page number to be printed. 

Press the spacebar. Type the word “of”. Press the spacebar. Click on the 
“Total Pages” icon. The Total Pages icon looks like a white sheet 
with the upper left corner bent, with two plus signs in the center. 

  This inserts the code &[Pages]. This causes the total number 
of pages to be printed. 

Click the “OK” button on the “Footer” dialog box. 
Click the “OK” button on the “Page Setup” dialog box. 
Click the File Save icon. 
Click on the Print Preview icon. The Print Preview icon looks like a white 

sheet with the upper right corner bent, with a magnifying class 
along the right edge. 

Click on the “Next” button above the Print Preview window. 
Click on the “Print” button above the Print Preview window. 
Make any other selections necessary to complete the print process. 

Set up headers and footers on the “Falling Body Lab” spreadsheet of the Excel 
Workbook. 

Click on the “Falling Body Lab” tab at the bottom of the Excel workbook. 
File | Page Setup… 
Click on the “Sheet” tab. 
Checkmark “Gridlines” in the “Print” section of the “Sheet” tab. 
Click on the “Header/Footer” tab. 
Click the “Custom Header” button. 
Click in the “Left Section” edit box. Type your name in the edit box. 
Click in the “Center Section”. Click on the File icon. The File icon looks 

like a white sheet of paper with the upper right corner bent, and a 
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green X centered on the left edge.  This inserts the code 
&[File]. This causes the file name to be printed. 

Click in the “Right Section”. Click on the Worksheet icon. The Worksheet 

icon looks like  This inserts the code &[Tab]. This causes the 
title on the worksheet tab to be printed. 

Click the “OK” button on the “Header” dialog box. 
Click the “Custom Footer” button on the “Page Setup” dialog box. 
Click in the “Left Section”. Click on the Date icon. The Date icon looks 

like two pages from a calendar.  This inserts the code &[Date]. 
This causes the date to be printed.  

Press the spacebar. Click on the Time icon. The time icon looks like a 

clock.  This inserts the code &[Time]. This causes the time to 
be printed. 

Click in the “Right Section”. Click on the “Page” icon. The Page icon 
looks like a white sheet with the upper left corner bent, with a 

pound sign # in the center.  This inserts the code &[Page]. This 
causes the page number to be printed. 

Press the spacebar. Type the word “of”. Press the spacebar. Click on the 
“Total Pages” icon. The Total Pages icon looks like a white sheet 
with the upper left corner bent, with two plus signs in the center. 

  This inserts the code &[Pages]. This causes the total number 
of pages to be printed. 

Click the “OK” button on the “Footer” dialog box. 
Click the “OK” button on the “Page Setup” dialog box. 
Click the File Save icon. 
Click on the Print Preview icon. The Print Preview icon looks like a white 

sheet with the upper right corner bent, with a magnifying class 
along the right edge. 

Click on the “Print” button above the Print Preview window. 
Make any other selections necessary to complete the print process. 


